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Um pouco de historia

Ao longo dos anos o AutoCAD sofreu grandes transformacdes e se consolidou em uma
plataforma CAD genérica, extremamente poderosa que proporcionou um aumento na produtividade e
causou uma verdadeira revolu¢@o na Industria de Projetos em geral. Isso se tornou realidade quando a
Autodesk® abriu parte da arquitetura do AutoCAD oficialmente na versdo 13 e decidiu disponibilizar parte
do codigo fonte nativo do AutoCAD para desenvolvedores em forma de SDK (Software Development Kit).
Isso proporcionou aos desenvolvedores que criassem aplicativos e solugBes muito mais robustas e

escalaveis.

Depois disso, 0 AutoCAD evoluiu para uma interface ainda mais robusta com a versdo 14 e em
seguida com a versdo 2000 conhecida como MDI (Interface de Mdltiplos Documentos). Atualmente, o
AutoCAD esta na versao 19.0 (AutoCAD 2013) nesta versao os desenvolvedores podem fazer uso de
tecnologias atuais como a plataforma .NET que permite utilizar linguagens modernas como C# e VB.NET

e desenvolver interfaces robustas com WPF (Windows Presentation Foundation).

O ObjectARX fazendo uso a liguagem C++ supera outras linguagens de programacgéo do
AutoCAD em relagdo a velocidade e performance. Isso acontece devido grande parte do cddigo do
AutoCAD ainda esta em C++ e pelo fato de parte da API .NET disponivel atualmente fazer acesso a

esse codigo C++.

A implementacdo completa de Entidades Personalizadas (Custom Entities) s6 esta disponivel
utilizando a linguagem C++. Essa grande capacidade do ObjectARX em C++ foi intensivamente usada
pela propria Autodesk para criar os outros produtos verticais no topo do AutoCAD R13. Hoje temos
in0meros produtos baseados no AutoCAD feitos pela propria Autodesk usando a API ObjectARX.
Podemos citar alguns produtos verticais como o AutoCAD MEP, Architecture e Civil. Esses produtos séo
exemplos do uso intensivo de entidades personalizadas para aproximar a ferramenta CAD ao cenario
real da indudstria. Ao invés de usarmos linhas e circulos para representarmos simbolos hidraulicos, o
AutoCAD MEP é capaz de criar entidades especificas como tubos, conexdes, etc. Isso torna o0 AutoCAD

adaptavel em cituacdes especificas.

Neste Tutorial, vocé iniciara o aprendizado com conceitos basicos de um aplicativo ObjectARX
fazendo uso das linguagens C++ e C#. A seguir vocé aprendera conceitos importantes sobre a estrutura

de dados do AutoCAD, como seus objetos sdo organizados, armazenados e como manipulé-los.



Escolha suas armas para programar para AutoCAD

Importante : Utilizaremos o AutoCAD 2013, Visual Studio 2010 SP1, ObjectARX 2013 e framework
.NET 4.0 neste Tutorial. Os mddulos ObjectARX criados com o ObjectARX 2013 sdo binariamente
compativeis com o AutoCAD 2013, 2014 e 2015. Mddulos compilados com ObjectARX 2012 ou

anteriores ndo serdo compativeis com a versdo 2013.

Entendendo a estrutura de Dados do AutoCAD

Para entender a estrutura de dados do AutoCAD e como as coisas acontecem precisamos
abstrair um pouco e imagina-la como um “banco de dados de objetos” que recebe comandos, reage a
eventos, dispara eventos e atua como um repositério de objetos. Esse banco de dados opera sob
algumas condicdes e regras bem definidas. Em determinadas situacdes percebe-se que sua

manipulacdo é um pouco burocratica o que garante sua integridade e a estabilidade.

Quando um desenho € criado no AutoCAD, na verdade é criado, excluido e modificado objetos
no seu banco de dados. O banco de dados do AutoCAD é um conjunto de objetos hierarquicamente
organizado cuja representagdo € um desenho representado pelo DWG. Quando é criado uma entidade
como a Line, nela j& estdo todos os dados necessarios para seja representada graficamente. O AutoCAD
nao armazena pixels entre os pontos inicial e final de uma linha, ele apenas armazena as coordenadas

dos pontos inicial e final dessa linha (X,Y,Z) e o desenho é realizado através da equagédo matematica.

O processo completo de criagdo de uma LINE ndo est4 completo apenas se especificarmos suas
propriedades mas requer ainda que vocé especifigue aonde e como esta LINE sera armazenada. Dentro
do banco de dados do AutoCAD existem diversos tipo de objetos do tipo containers cuja finalidade é
armazenar e manter objetos. Cada container tem seus proprios procedimentos e regras para armazenar
e recuperar seus objetos. Na maioria dos casos, é responsavel por manter e salvar seus objetos. No
exemplo da LINE ela poderia ser armazenadas num container de entidades. Esses containers de
entidades sdo chamados de Block Table Records (BTR). Cada BTR pode armazenar diversos tipos de
entidades como lines, circles, texts, blocks, etc. O diagrama da Figura 1, mostra parte da estrutura de
dados do AutoCAD.
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Figura 1 — Banco de dados do AutoCAD estruturado em containers

A Figura 1 mostra que as entidades podem ser armazenadas nos containers Model Space,
Paper Space ou outros Block Table Records. Esses outros BTRs podem ser uma pagina de Layout ou
até mesmo outro Bloco. Cada bloco inserido em um desenho do AutoCAD é uma entidade Block
Reference que aponta para o Bloco original que é um Block Table Record. Por isso, quando editamos
um Bloco com o comando REFEDIT ele reflete em todas as cépias desse Bloco pois na pratica vocé esta
editando o Bloco original. A seguir, veja um trecho de cddigo que demonstra o processo de criagdo de
uma entidade LINE em C++. O cddigo ir4 criar uma LINE do ponto (1.0, 1.0, 0.0) até o ponto (10.0, 10.0,
0.0):

01 /'l cria dois pontos e unma |linha

02 AcGePoint3d startPt (1.0, 1.0, 0.0);

03 AcCGePoi nt 3d endPt (10.0, 10.0, 0.0);

04 AcDbLi ne* pLine = new AcDbLine (startPt, endPt);

05 /'l abre o objeto container apropriado

06 AcDbBI ockTabl e* pBl ock = NULL;

07 AcDbDat abase* pDB = acdbHost Appl i cati onServi ces()->wor ki ngDat abase() ;
08 pDB- >get Synbol Tabl e( pBl ock, AcDb: : kFor Read) ;

09 AcDbBI ockTabl eRecord* pBTR = NULL;

10 pBl ock- >get At (ACDB_MODEL_SPACE, pBTR, AcDb::kForWite);
11 pBl ock->cl ose();

12 /'l agora, armazena a entidade no contai ner

13 AcDbObj ectld 1d;

14 pBTR- >appendAcDbEntity(ld, pLine);

15 pBTR- >cl ose();

16 pLi ne->cl ose();
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O processo de criagdo da Line € similar ao processo de criagdo das outras entidades e consiste

dos seguintes passos:

» Primeiro instanciamos um ponteiro para a classe da entidade (alguns construtores irdo permitir e

exigir que vocé fornega alguns parametros);

» A seguir, precisamos abrir 0 Block Table aonde iremos encontrar o container apropriado. Nesse

exemplo nds iremos usar o container Model Space;

» Depois disso, nos abrimos o Model Space (um Block Table Record) e adicionamos a ele a

entidade recentemente instanciada.

E muito importante notar que esse processo exige que vocé abra e feche cada objeto especifico.
Uma vez que a entidade seja adicionada ao banco de dados ela vai receber um identificador Unico
associado automaticamente pelo banco de dados do AutoCAD, chamado AcDbObjectld. Essa é a chave
de acesso a entidade sempre que vocé quiser. Ele é valido e permanece inalterado somente durante a

sessao de desenho do AutoCAD.

Essa é apenas uma visdo geral do processo para deixar claro 0s passos necessarios para criar
uma entidade simples e para demonstrar o processo de acesso aos métodos e procedimentos. A seguir
vocé ird aprender a criar um aplicativo ObjectARX usando o Visual Studio e em seguida criar 0 mesmo

aplicativo utilizando a plataforma .NET.

Visao Geral do Aplicativo ObjectARX

O Aplicativo ObjectARX é uma DLL (Dynamic Link Library). Isso permite com que ele seja
carregado dentro do AutoCAD em tempo de execucgdo. Esse conceito evoluiu posteriormente para o
Object Enabler que foi introduzido ha algum tempo. Esse conceito divide o aplicativo em duas partes. O
Object Enabler € um aplicativo ObjectARX contendo apenas um conjunto de classes para objetos e
entidades. Ele é chamado de ObjectDBX e é compativel com todas as solu¢cbes Autodesk construidas
com a tecnologia RealDWG como os visualizadores DWG e todos os outros verticais AutoCAD. As
Ultimas trés letras do nome determinam sua finalidade: ARX (AutoCAD Runtime Extension) e DBX
(Database Extension). Normalmente os aplicativos sdo constituidos por diversos médulos ARX e DBX

que irdo representar as seguintes funcionalidades:

Interfaces : Irdo conter todas as janelas, comandos, eventos e qualquer outro codigo relacionado
as interfaces do AutoCAD. Ele sera um aplicativo ObjectARX representado por uma DLL (extensao de

arquivo .arx) e sera compativel somente com o AutoCAD e seus verticais;
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Classes customizadas _: Irdo conter todas as classes customizadas (objetos e/ou entidades) que

ndo requerem a presenca do aplicativo AutoCAD mas apenas do RealDWG. Ele sera um aplicativo
ObjectDBX representado por uma DLL (extensdo de arquivo .dbx) e n&o podera conter qualquer
chamada ou referéncia a codigo especifico do AutoCAD. Ele podera ser carregado dentro do AutoCAD,

seus verticais e todos os aplicativos Autodesk com suporte ao ObjectDBX;

Os dois moédulos ARX e DBX podem ser carregados no AutoCAD usando um dos seguintes

procedimentos:
* Comando ARX;
e Arquivo acad.rx;
* Comando APPLOAD;
e Método AutoLISP arxload() ou método ObjectARX acedArxLoad() ;
* Opgoes de inicializagdo do AutoCAD: —Id ou /Id;
« Entradas de Registro do Windows para Demand loading (carregamento automatico).

Esses procedimentos podem ser usados em situagdes diferentes dependendo dos requisitos do

seu aplicativo e dos mecanismos de distribui¢cdo e instalagao.

Utilizando o ObjectARX Wizard

Para facilitar nossa vida vamos utilizar o wizard do ObjectARX, esse plug-in vai nos ajudar a criar
um aplicativo ARX ou DBX e caso seja necessario também auxiliara no processo de criagédo das classes
personalizadas. (0] instalador do ARXWizard pode ser encontrado no link

http://images.autodesk.com/adsk/files/objectarx_wizards 2013.zip. Basta executar esse instalador (com

o Visual Studio fechado) que ele ira criar uma nova opg¢éao de tipo de projetos dentro do Visual Studio na
janela “New Project ” (dentro da categoria Visual C++) como mostrado na Figura 2.
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4 Visual C++
ATL
iR
General
MFC
Test
Win32
Autodesk
4 Other Lenguages
Visual Basic
4 Visual C#
Autedesk
Windows
Web
Office.
Cloud
Repertina

Name:
Location:

Solution name:
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Para criar um novo moédulo ARX ou DBX,

T ————————————————
Recent Templates | .NET Frameworic4 tes

| Sort by: | Default =]l

[ searc »|

";\ ObjectARX/DBX Project

[RIX]

Online Templates

Visual Cs+

AnProjectl

studio )

AnProjectl

g P |

Type: Visual C++

ObjectARX/DBX Application Wizard for
AutoCAD

abra o Visual Studio e faca o seguinte:

e Abra 0o menu File > New >

Project... ;

» Selecione ObjectARX dentro do
grupo Visual C++ > Autodesk ;

» Selecione o item ObjectARX/DBX
Project ;

[V] Create directory for solution

» Especifique o nome do projeto, pasta
e nome da solugao;

I Add to source control

ok Cancel

Figura 2 — Janela New Project do Visual Studio

» Clique OK para continuar.

A seguir, vocé precisa escolher o tipo de projeto (ARX ou DBX), suporte adicional do SDK, MFC,

COM e .NET. Essas op¢Oes séo descritas a seguir:

ObjectARK/DEX Application Wizard for AutoCAD - AnProjectl

Overview
Application Type:
MEC Support
COM Options
NET Gptions

About,

Welcome

These are the current project settings:
o Your Registered Developer Symbol: AU
o Pure ObjectaRX Application
@ No MFC Suppart
« Mot COM Server
+ Mot a NET mixed managed modue

Click Finish from any window to accept the current settings.

After you areate the project, see the project’s readme. ixt file for informaton
bout the project features and fles that are generated.

[¥] implement _DEBUG preprocessor symbol

Choose this option to define the preprocessor symbol _DEBUG in your debug
project configuration, IF you choose this option, the Wizards wil areate the
usual _DEBUG workaround in your Stdafih , honever none of the
Microsoft/Autodesk header shauld be ncluded while this symbel s defined.

e ) )

ObjectARK/DEX Application Wizard for AutoCAD - AnProjectl

=

Overview

Applcation Type
MFC Support
COM Options
NET Options

Appiication Type

Project type:
© SRR (ALESCAD EEASan
Chaose this aption to create 4 standard ObjectARX application for
AutoCAD project to be loaded in AutoCAD,

ObjectDBX (Custom Object Enabler)
Choose this option to create a standard CbjectDBX Custom Cbject
Enabler application. A Custom Object Enabler Appication defines custom
object and custom entity which can be loaded into al RealDWG host
applications such 25 AUtaCAD [ VoloView [

<Previous | [ Mext> | [ Fmish | [ Cancel

Welcome

Especifique seu simbolo de desenvolvedor para ser usado
como prefixo para todas as classes (isso evitara conflito com
outros aplicativos ObjectARX/ObjectDBX de outros usuarios

ou empresas).

Se desejar (recomendado), habilite a op¢do do simbolo

_DEBUG que ira permitir desvios no codigo durante

procedimentos de depuragéo.

Application Type

Selecione o tipo de aplicativo: ObjectARX ou ObjectDBX.



ObjectARK/DBX Application Wizard for AutoCAD - AnProjectl (o8 ]
MFC Support
Overvien MECsupport:
Application Type Mo MFC Suppart
MFC Support
COM Options
Vo © e DL g EC Shard DL Feommnded or VEC ppart)
[7] AutocAD MFC Extension Support.
<Previous | [ Mext> |[ Emsh | [ Cancel |
ObjectARX/DEX Application Wizard for AutoCAD - ArxProjectl [E==]
COM Options
Overview COM Server Ontions:
e @ fisks o server
MFCStport ' Implement a COM server
ol 5t Implementa COM server using ATL (recommended)
WNET Options
'COM Client Options:
@None
Import CbjectDBX COM interfaces
Import AutoCAD COM interfaces
<Previous | [ Next> |[ Fmish |[ Concel |
ObjectARY/DEX Application Wizard for AutoCAD - AncProject] [ ==
.NET support
v HET Options:
Kerkcat e [T1 1RET mixed managed code support
W Support
COM Optons NET Extensions:
o 7] AutocAD architecture support
L AutoCAD MEP
< Previous [ Bnsh ][ goncel |

Esse processo ird criar o “Esqueleto do Aplicativo
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MFEC Support

Se o0 seu aplicativo utilizar a biblioteca MFC é necessério
habilitar o suporte através da opg¢do MFC support.
também utilizar os controles

AutoCAD MFC, habilite essa opcéo.

Adicionalmente, se for

*Somente aplicativos do tipo ARX podem utilizar
controles AutoCAD MFC.

0s

COM Options
Se o0 seu aplicativo for utilizar as bibliotecas COM para
cliente ou servidor (ATL recomendado), escolha as opgbes

necessarias.

.NET Support

Se planejar desenvolver um aplicativo do tipo mixed-mode,
habilite esta op¢do. Essa opcdo ir4 adicionar suporte ao
.NET Framework além do acesso as classes AutoCAD .NET

de dentro do codigo C++.

" que irA evitar um gasto de tempo

consideravel configurando tudo manualmente. Uma vez finalizado o processo de cria¢do, a solution do

seu aplicativo sera algo como apresentado na Figura 3.
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B

> 1 x

; Selution "AmProjectl’ (1 project)

4 | AnProject1

@Zi External Dependencies
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Para compilar esse projeto, precisamos adicionar 0s

caminhos do ObjectARX (pasta include e lib) nas opg¢bes do

projeto. Cliqgue com o botédo direito do mouse sobre o projeto e

selecione Propertie, abra a entrada VC++ Directories . Siga as

4

4

]

| =¥ Header Files
|n] DocData.h
|1 Resourceh
] StdAfch

|=r Resource Files
23 ArxProjectl.rc

[ Source Files

& acmEntryPoint.cpp

c+ AnProjectl.cpp
¢+ DocData.cpp
¢+ StdAfr.cpp
ReadMe bt

Figura 3 — Solution ObjectARX C++

finalizar.

instrucbes das Figuras 4 e 5 e a seguir cliqgue em OK para

-
ArxProjectl Property Pages -

|2 it

Configuration:

Active(Debug)

* | Platform:

Active(Win32)

v| I Configuration Manager.., |

Fl

» Commeon Properties
a Configuration Properties

. CICH+

7

> Manifest Tool
|» Resources
[+ XML Document Generator

7

i» Build Events
[+ Custom Build Step

General
Debugging
VC++ Directories

Linker

Browse Information

Executable Directories
Include Directories

Reference Directories

Library Directories C:\ObjectARX 2013\lib-win32;${LibraryPath)
S{VCInstallDirjatlmfc\srchmfc; S{VCInstall Dirlatlmfc\src mfom; S{V CInstall Dir) athmif c\sr
S{(VCInstallDir)include; S (VCInstalIDir)atimfchinclude: S (WindowsSdkDir)include; S (Framg¢

Source Directories

Exclude Directories

Library Directories
| Path to use when searching for library files while building a VC++ project. Corresponds to envirenment variable
| LIB.

S{VCInstallDir)bin: S (WindowsSdkDir) bin\ NETFX 4.0 Tools: ${Wind owsSdkDir)bin: ${V5In

CADbjectARX 2013\inc;C:\ObjectARX 2013\inc-win32;$({IncludePath)
C:ADbjectARX 2013\in;C:\ObjectARX 2013\inc-win32;${ReferencePath)

[=]

[

0K

J| Cancel |[ Apply

Figura 4 — Referéncias do ObjectARX x86
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= z N
ArxProjectl Property Pages — - &I&l
Configuration: | Active{Debug) * | Platform: |04 v| I Configuration Manager.., |

» Commeon Properties | a
4 Cenfiguraticn Properties Executable Directories S{VCInstallDir)bin'uB6_amdad; SV CInstallDirbin: S(WindowsSdkDinbinMETFX 4.0 Tool
General Include Directaories C\ObjectARX 2013\inc;C:\ObjectARX 2013inc-x64; ${IncludePath)
Debugging Reference Directories  C\ObjectARX 2013\inc;C:\ObjectARX 201 3Vinc-x64:$(ReferencePath)
MChEnetiones C:\ObjectARX 2013\lib-x64;5(LibraryPath) [=]
- G- Source Directories S{VCInstallDirjatlmifc\srcimfc S{VCInstall Dir)atlmfchsrch mfom; ${V CInstall Dir) athmfc\ s
@ Linker Exclude Directories S(VCInstallDininclude: S (VCInstalIDin atimfe\include:S(WindowsSdkDininclude:S{Fram
> Manifest Tool
|- Resources
- XML Document Generator
= Browse Information
> Build Events
|+ Customn Build Step
Library Directories
| Path to use when searching for library files while building a VC++ project. Corresponds to environment variable
F] m |y | | LB

[_ OK ]| Cancel H Apply

Figura 5 — Referéncias do ObjectARX x64

Para compilar o projeto, primeiramente mude a configuracdo de compilagdo para Release. Para
fazer isso, va ao menu Build , escolha Configuration Manager... , selecione Release na caixa “Active
solution configuration ”. A seguir, vd ao menu Build e escolha Build Solution . Vocé deve obter algum

resultado parecido com a tela de Output/Build a seguir (Figura 6).

10
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Output - 1 x [
-3
Show output from: | Build @ @S| = | = 2
g
e Rebuild All started: Project: ArxProjectl, Configuration: Release x84 ------
1>Build started 9/12/2812 2:23:58 PM.
1»PrepareForBuild:

1> Creating directory "c:‘\users\ofcdesk\documentsivisual studio 2@18%“Projects\ArxProjectlix64\Release\".
1»InitializeBuildStatus:

1> Creating "xB4\Release\ArxProjectl.unsuccessfulbuild" because "AlwaysCreate" was specified.
13>C1Compile:

1> StdAfx.cpp

1> acrxEntryPoint.cpp

1> ArxProjectl.cpp

1> DocData.cpp

1xLink:

1> Creating library xG4\Release\AUArxProjectl.lib and object x64\Release\AUArxProjectl.exp

1> Generating code

1> Finished generating code

1>rxapi.lib(libinit.obj) : warning LNK4@99: PDB 'rxapi_cl.pdb' was not found with 'rxapi.lib{libinit.obj)' or at 'c:\users\ofcdesk\documents\visual studio
1> ArxProjectl.vcxproj -» cilusers\ofcdeskidocumentsivisual studic 2e@1@\Projects\ArxProjectl\x64\Release\AUArxProjectl.arx
1>FinalizeBuildStatus:

1> Deleting file "x84\Release\ArxProjectl.unsuccessfulbuild”.

1> Touching "x64\Release\ArxProjectl.lastbuildstate".

1>

1»Build succeeded.

1>

1>Time Elapsed 2@:88:11.86

===—====== Rebuild All: 1 succeeded, 8 failed, B skipped ==========

m

1 0

IF. Code Definition Window JS e

Figura 6 — Janela de resultados da compilacéo

Agora basta carregar seu aplicativo dentro do AutoCAD. Abra o AutoCAD e acione o comando
AP. Procure pelo arquivo ArxProjectl.arx dentro da pasta ArxProjectl\Release, selecione o arquivo e
click em LOAD.

Utilizando o DotNet Wizard

Para utilizar os recurso da plataforma .NET no AutoCAD é necessario ter instalado o Visual
Studio 2010 e o AutoCAD 2013.

Nos exemplos faremos uso da linguagem C#. Vale lembrar que o AutoCAD instalado é
necessario para permitir a execucao, teste e depuragdo dos exemplos, mas é possivel compilar o codigo
fazendo uso somente das referéncias encontradas no SDK do ObjectARX disponiveis em:

http://www.objectarx.com.

Para criar um plugin .NET para AutoCAD iremos utilizar o wizard disponivel em:

http://images.autodesk.com/adsk/files/autocad 2013 dotnet wizards.zip, 0S passos Sdo 0s seguintes:

11
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|.NET Frameworkd = | Sort by: | Defauit | search Installed Templates 2|
Installed Templates
B Auocan 203 csharp plugin Visual C& TomeliVERBLCY
Visual G+ 7 This is a basic AutoCAD Plugin in €2
4 Other Languages
Visual Basic
4 Visual C#

Autodesk

Windows

Web

Office

Cloud

Reporting

SharePoint

Sitverlight

Test

weF
MName: AutoCAD CSharp plug-inl
Location: ciusershofedesK\documentshvisual studio 2010\Projects - | Browsew
Solution: [ Create new solution -
Solution name: AutoCAD CSharp plug-inl 7] Create directory for solution

|| Add to source control
]

Figura 7 — Janela New Project do Visual Studio

Specify the location of the folder inside the ObjectRX SDK that contains AcMgd dll
Specify the AutoCAD executable location
C:‘.-\F.‘roglam i:'iles‘-;%.r.todesk"tﬂr.to'[fﬁD ZI}'IJ

J

Aszemblies to reference Run Az |ACA
AoCAD |
B toCAD Database [ AcDx
AutoCAD AutoTAD Core [ AutoCAD Interop Comman
[ AdWindows [] AuteCAD Interop
[ AcWindows [ B-Rep
[ AcTe [ AcCui

Select Al Clear All

g
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Para criar um novo plugin .NET, abra o

Visual Studio e faga o seguinte:

¢ Abra o menu File > New > Project... ;

» Selecione AutoCAD 2013 Csharp
plug-in dentro do grupo Visual C# >
Autodesk;

¢ Especifique o nome do projeto, pasta e
nome da solugéo;

Clique OK para continuar.

[ ok ][ concel |[ bout. |
]
Figura 8 — Janela de configuraces do wizard
Esse processo ira criar o “Esqueleto do Aplicativo” que ira evitar um gasto de tempo

consideravel configurando tudo manualmente. Uma vez finalizado o processo de cria¢do, a solution do

seu aplicativo sera algo como apresentado na Figura 9.

12



Escolha suas armas para programar para AutoCAD

Solution Explorer » 0 X

; Solution 'AuteCAD CSharp plug-inl' (1 project)
4 (5 AutoCAD CSharp plug-inl
+  [=d Properties
«d] References
#] myCommands.cs
] myPlugin.cs

Figura 9 — Solution plugin .NET CSharp

Compile o cédigo acessando o menu Build e escolha Build NOME_DO_PROJETO, devera obter

resultados semelhantes a janela abaixo:

CQutput v 4 x

Show output from: |Bui|d '| | 3 | &l 13 | ;1| =
------ Rebuild All started: Project: AutoCAD CSharp plug-inl, Configuration: Debug Any CPU --
Build started 9/12/2912 4:23:3@ PM. B
CoreResGen:
"C:\Program Files (x86)\Microsoft SDKs\Windows\v7.8A\bin\NETFX 4.8 Tools\resgen.exe" /fuseSo
Processing resource file "myCommands.resx" into “"obj\Debug\AutoCAD_CSharp_plug_inl.MyComman
GenerateTargetFrameworkMonikerdattribute:
Skipping target "GenerateTargetFrameworkMonikerAttribute” because all output files are up-to-
CoreCompile:
C:\Windows\Microsoft.NET\Frameworkyv4.@8.3@319\Csc.exe /noconfig /nowarn:17@1,1782 /nostdlib
CopyFilesToOutputDirectory:
Copying file from "obj\DebugiAutoCAD CSharp plug-inl.dll" to “bin‘\Debug\AutoCAD CSharp plug| |
AutoCAD CSharp plug-inl -» C:\Users\ofcdesk\Documentsivisual studic 2818\Projects‘\AutoCAD C
Copying file from "obj\Debugi\AutoCAD CSharp plug-inl.pdb" to "bin‘\Debug\AutcCAD CSharp plug

Build succeeded.

Time Elapsed @8:88:88.89
=== Rebuild All: 1 succeeded, @ failed, @ skipped =

« [am] v
Figura 10 — Janela de resultados da compilagdo

Agora basta iniciar o AutoCAD e execute ocomando NETLOAD para carregar a DLL e executar o

comando criado pelo wizard MyCommand.
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Escolha suas armas para programar para AutoCAD

Caso nio queira usar o wizard basta seguir os passos abaixo:

Iniciar o Visual Studio e criar um novo projeto. Este projeto deve ser uma Class Library. Este tipo

de projeto ira produzir uma DLL, ou assembly, o que funciona como uma extenséo ao aplicativo base,

neste caso AutoCAD.

-] | Scarch Instelled Tempiates »|

Installed Templates

2 Type: Visuel €2
Aproject for creating a C# class library
(.dily

_ck| Windows Forms Application Visual C#

4 Visual C++

g‘: ‘;_ﬂ“ WPF Application Visual 2
General
MFC E{:ﬂ Console Application Visual ¥ (=]
Test
Win22 %ﬁ ASP.NET Web Application Visual C2
Autodesk

4 Otherlanguages E Class Library Visual C#
Visual Basic
Vil CE S ASPNET MUC 2 Web Application Visual C2
Visual F# =0

Other Project Types
Database

cH| silverlight Application

Visual G

Test Projects
2 O Siverlight Class Library Visual C#
Online Templates i
ok Visual &

(Chggy  WCF senvice Applicston

Name: MyProjectDothlet

e

7] Create directory for solution

Location: studio j =

Solution name: MyProjectDothet

["| Add te source <ontrol

oK Cancel

Figura 11 — Janela New Project do Visual Studio

Para criar um novo projeto, abra o Visual
Studio e faca o seguinte:

e Abra o menu File > New > Project... ;

» Selecione Class Library dentro do
grupo Other Languages > Visual C#;

» Especifigue o nome do projeto, pasta e
nome da solugéo;

Clique OK para continuar.

Apés criar o projeto é necessario adicionar as referéncias as DLLs AcMdg, AcDbMgd e

AcCoreMgd.dll. A primeira permitira acesso aos recursos de interface, ou seja, a aplicacdo acad.exe em

execucao. A segunda vai permitir acesso a base de dados do AutoCAD, que sera os arquivos DWGs em

execucgdo e a Ultima ao core console que foi introduzido na versao 2013.

Para adicionar as referéncias, cligue com o botdo direto no nhome do projeto, depois acesse

Add Reference:

- 4 x it >

1% MyProjectDothet. Classl
Flusing System;
Lusing System Callertinns Gene

Selution Explorer
Sl SEa
g Solution 'MyProjectDotNet' (1 pro
4 | E] MyProjectP Mot
. [Zd| Propert Build
Rebuild
Clean !
Add »
Add Reference...
Add Service Reference...

i Referen
] Classl.c

View Class Diagram

Set as StartUp Project
Debug ¢

Figura 12 — Solution plugin .NET CSharp
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Em seguida localize a pasta do
AcCoreMgd.dll e clique OK:

Escolha suas armas para programar para AutoCAD

ObjectARX 2013\inc e selecione AcMgd.dll, AcDbMgd.dll e

-
oo Add Reference

| .NET | COM | Projects| Browse | Recent|

Look in: inc

Mame

| % AcCoreMgd.di
%] AcCuidll

| [ AcDbMgd.dil
%) acdbmgdbrep.dil

-1
Date modified
2/6/2012 7:40 PM
2/6/2012 7:52 PM
 2/6/2012 7:40 PM
2/6/2012 7:56 PM
2/6/2012 7:57 PM

* Er

»

Ty

%] AcDx.dll
IE Rehvigd.dil

2/6/2012 7:57 PM

R0 D T.50 DRA

< T | ¥
File name: "AcMad.di" " AcCoreMad.dil" "AcDbMgd dll" -
Files of type: | Component Fles {~.dll;"tb;".olb;" ocx:” exe " manifest) & l

| o

|| concel |

Figura 13 — Incluindo referéncias ao projeto

Importante : E preciso marcar as referéncias como Copy Local igual a falso. Isso ird evitar a copia

desnecesséria destas DLLs para a pasta do projeto, assim como erros de execug¢do ou depuragéo.

Acesse as propriedades do projeto, em seguida a aba References, marque as novas referéncias e na

paleta propriedades marque Copy Local como False, como na figura abaixo:

=i iE
:; Selution 'MyProjectDotNet’ (1 proy
4[] MyProjectDotNet
|=d| Properties
4 | _ References
[-3 AcCoreMgd |
5 AcDbMgd |
-2 AcMgd |
0 I\-'iic.ro;oft.CSharp
-3 System
423 System.Core
-2 System.Data
-3 System.Data.DataSetExt]
-3 Systern.Xml
42 System.Xml.Ling
#] Classl.cs

Solution Explorer AR Properties

Aliases

Copy Local
Culture
Description
Embed Interop Types
Identity

Path

File Type
Resolved
Runtime Version
Specific Version
Strong Name

Version

global
False

¥0q|00] . J210jdx3 janiag e

False

Assembly
True
v4.0.30319
False
False
19.0.00

Figura 14 — Verificando Property Copy Local = False para evitar conflitos
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Escolha suas armas para programar para AutoCAD

Exemplos em C++ e C#

Alguns exemplos serdo demonstrados em sala.

Material Adicional

Through the Interface blog
http:/through-the-interface.typepad.com

AutoCAD.NET Developers Guide
hitp:/Amww.autodesk.comv/autocad-net-developers-quide

Grupos de Discusséo
http:/discussion.autodesk.com/forums/category.jspa?categoryiD=8

Autodesk Developer Network
http://adn.autodesk.com/adn/

ARX & Dummies
http://arxdummies.blogspot.com.br/

AutoCAD DevBlog
http://adndevblog.typepad.com/autocad/

Conclusao

Nesse curso vocé aprendeu como funciona a estrutura de dados do AutoCAD, conceitos
bésicos, como criar plugins utilizando o ObjectARX C++ Wizard e com a plataforma .NET. O ObjectARX
€ realmente fantdstico e permite que vocé liberte sua mente e consiga colocar em prética
funcionalidades realmente interessantes e poderosas. Espero que tenha gostado e se interessado por

esta poderosa ferramenta.
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